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THE HOMEPAGE  

 
Vero Beach Computer Group 

 Vero Beach Computer Group is a self-help goup that provides help to members who want to improve their knowledge of computers and ac-
cessories.  Our motive is to share our experiences and give members a chance to learn and help each other.  Every effort is made to share 
accurate information; however, no representations or warranties either express or implied is made as to its accuracy. 

   Dale  Leatherman,  o w n e r  o f  MainSa i lData 
(www.mainsaildata.com), will be the speaker at the General Member 
meeting of the Vero Beach Computer Group on June 4, at 7PM at the 
Main Library.  He will discuss solutions to the five most frequent com-
puter repair issues that come to his repair shop and how to remedy them.  
In order, they are: 
 

•  Virus related 
• Hard drive failures 
• Driver failures and driver incompatibility (Vista failures, the         

most recent example) 
• Traced to bad memory – file corruption 
• Overheating – resulting in CPU and memory failure 

 
 Dale is a native of Vero Beach, who holds an Associate Electrical Engi-
neer certification from Indian River Community College, and he is a Micro-
soft Certified professional.  He has many home and business clients, who 
rely on him to maintain their computer  information systems in top notch 
operation.  In addition to his computer repair business, Dale also writes 
computer programs and both static and dynamic websites – a commer-
cial business website, like, 
for example, on-line bank-
ing, is an ex- ample of a 
“ d y n a m i c ” website.  He is 
fully quali- fied in all as-
pects of computer re-
lated inter- operability – 
home wire- less networks, 
among many others - and informs that he will be prepared to answer vir-
tually all and any questions of those who attend the June 4 meeting.  This 
promises to be a very relevant and informative program, and all VBCG 
members and quests are encouraged to attend. 
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What To Do When….                          You Can’t Burn a CD/DVD 
Smart Computing, February 2007 
 
For the most part, DVD-R/RW (recordable/rewriteable) and CD-R/RW drives work as advertised, giving us a conven-
ient, affordable way to make archival copies of software, media files, and the like and to create our own multimedia 
masterpieces. Yet sometimes the burning process (that of writing data to a CD or DVD) stops midway, with some en-
igmatic message appearing on our screens; or the results won’t play properly; or the drive itself is no longer recognized 
by Windows. It’s enough to make one yearn for the days of audio cassettes and VHS tapes. The copies you made 
were always a degraded image of the original, but barring mechanical failure in the media, they worked.  
 
The good news is that there are logical reasons for these problems, and we’ll cover several of them here. We’ll also try 
to give you the most likely and least expensive solutions, so you don’t blow your bankroll on a state-of-the-art combo 
drive only to discover that it, too, refuses to copy your entire collection of home movies.  
 
Problem: I got a real deal on 300 blank CD-Rs from an off-brand manufacturer. But I’ve found that only five of 
the first 15 I tried actually worked; the rest were rejected by my CD burner.  
 
Solution: We all like bargains, but the reason many off-brand CDs are such a great deal is that their manufacturers 
have less-than-exacting standards where quality control is concerned. This even applies to some name-brand discs, 
which are simply rebranded, priced-up versions of off-brand CDs. We’ve had very good luck with Verbatim and Maxell. 
They’re not the least expensive CDs around, but when you factor in frequent duds lost to bad manufacturing that show 
up on some other labels, they’re more cost-effective. So before you decide your software or CD player is bad, go out 
and buy some really good media. You’ve saved some real money if that solves your problem.  
 
Problem: The sound of my burned CD copy is very distorted.  
 
Solution: This could be due to several possible issues. First, have you checked to make sure that the source disc is 
still in good shape? Contrary to manufacturer claims in the early years of CD technology, CD surfaces can deteriorate 
over time. Second, are those source files of decent quality? There are MP3 files available with a bit rate as low as 
32Kbps (kilobits per second; although 80 or 96Kbps is more common). You can fit a lot of material on a disc using such 
a low bit rate, but the audio quality will suffer. For good, relatively distortion-free transfers, 128Kbps is a good minimum 
bit rate.  
 
Finally, is your system capable of handling the write speed you’ve chosen? Just because the CD-ROM drive comes 
with a very high setting doesn’t mean your computer can automatically handle that. Try authoring discs at a lower write 
setting and see if that lessens or eliminates the distortion.  
 
Problem: I’ve been burning CD-RWs lately because I like being able to reformat them and overwrite the old 
contents. But I now find that the music compilation discs I’ve made and updated over time won’t play on all my 
gear, and a couple of my CD-RWs won’t even play in players that previously worked fine.  
 
Solution: Yes, rewriteable CDs are great when you want to keep just a few discs around. You can theoretically replace 
their contents as often as you wish, as opposed to CD-Rs, which only let you write to them once.  
 
But there are a couple of drawbacks to CD-RWs. First, older readers may not recognize them, and that seems to be in 
part what you’ve discovered. Second, some have raised concerns 
that the material that makes up some CD-RWs’ data layer can too 
easily go bad and become unreadable, though when this happens 
it usually occurs after a couple of years, not weeks or months.  
 
So CD-RWs are a good, economical bet if you don’t plan to use 
them for archival purposes and if you only want to play them on 
equipment purchased in the last couple of years.  
 
CD-R media, on the other hand, has been touted as having a life 
expectancy of 50 years barring manufacturing defects, scratches, 
high heat, and/or humidity. In any event, we recommend that you 
play it safe; if you want to keep a CD forever, make a fresh 
backup copy every few years. 
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TIPS & TRICKS  FROM OUR WEBMASTER,  TIM GLOVER 

 
 v1.28 [112k] W98/2k/XP FREE, Lockergnome Windows Digest, 5-10-03 
 http://www.snapfiles.com/get/k9.html 
 
 K9 is an anti-spam e-mail filtering application that works in conjunction with your regular POP3 e-mail program, and automati-
cally classifies incoming e-mails as spam (junk e-mail) or non-spam. The program uses intelligent statistical analysis that can re-
sult in extremely high accuracy over time, and eliminates the need for maintaining dozens of rules or constant updates to be 
downloaded. K9 learns from what you are considering spam and will automatically tag all future e-mails that match the pattern. 
You can then set up rules (in Outlook, Outlook Express, etc.) to delete or move the spam-tagged messages. The initial results will 
be moderate; however, after processing a few dozen e-mails, K9 will detect a very large percentage of the spam and further im-
prove accuracy over time. The advantage of this is that the program is able to filter spam based on your personal e-mail statis-
tics, rather than a generic or global list. The interface allows you to view your mail history and change the status for certain mes-
sages, thereby automatically updating the filter settings. Additional features include whitelist and blacklist, long-term statistics, 
and more. K9 does not delete any messages automatically, but only tags them for further processing. 
  
Knowing Poe, Lockergnome Windows Digest, 5-10-03 
 http://knowingpoe.thinkport.org/ 
  
Life and times Edgar Allan Poe - In tenth grade, I read his "The Masque of the Red Death." It was a fascinating story, but gave me 
chills and a few bad dreams. Entering the site sets the right tone for presenting his works, with its black and white scheme and a 
raven in the shadows. The infamous raven, from his poem, appropriately provides inside information throughout the Web site. An 
impressive feature provides suggestions to parents for helping children with their school activities. More sites should consider 
this example and consider implementing such features, because we learn best with real world activities. Explore the library, read 
a few poems, or watch actor John Astin read "The Raven" as Poe. 
 
AncientScripts.com, Lockergnome Windows Digest, 5-10-03 
 http://www.ancientscripts.com/ 
   
Writing systems and linguistics - Another goodie for language lovers. Writing systems is a topic I've heard little about, and the 
Web site offers much insight into the topic. Looking around the site, you can't help but get the feeling the creator is passionate 
about the topic, especially since he has maintained and updated this site since 1996. Explore Writing systems by types, families, 
and regions. Take a break from learning and play CryptoGlyphs, a game similar to cryptograms using glyphs rather than Roman 

letters. Look for patterns in the puzzle. For example, in the puzzle I 
completed, I looked for three-lettered words assuming they 

wereeieeitherteith"the" or "and" and worked my way from there. It 
paid off, and the answer was a Mark Twain quote. Here's one of his for you: "The unspoken word is capital. We can invest it or we 
can squander it." 
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Camera Fans 
  The Indian River Photo Club, sponsored by Cannon, is 
offering a wonderful Digital Photography Seminar to be 
held at the Kight Building, at Indian River Community 
College in Fort Pierce. 
   World Famous bird photographer Arthur Morris will be 
there with his books and photographs.   
   The cost of the seminar for Indian River Photo Club 
members is $15.00 and $25.00 for others.  Please reg-
ister in advance by sending an e-mail to Pat Rice at ir-
photoclub @gmail or mailing  your name, contact info, 
and check to: 
       Indian River Photo Club, Inc 
 P.O. Box 1491 Vero Beach, Fl 32961 

http://www.snapfiles.com/get/k9.html
http://knowingpoe.thinkport.org/
http://www.ancientscripts.com/
http://www.vbcg.orgVOLUME25


www.vbcg.org                                                          VOLUME 25, ISSUE 6 

   MEETINGS AND SIGS 

All meetings and SIGs are held in the Indian River County Main Library  
located at 1600 21 Street, Vero Beach, Florida 

Cameras, Scanners, Frank Lombard        June 5                    794-2293 History Room 

Photoshop Elements Frank Lombard        June 6                    794-2293 Media Room 

Using Personal Comp Jean Grider               June 7                    569-4289                          History Room 

MS Power Point Wayne Kleinstiver   June 12                   539-8538 History Room 

Macs Eleanor Ryan           June 16                  562-2869 History Room 

Macs Joe Piazza                June 16                  567-9004 History Room 

Mobile Computing Tim Glover               June 20                  589-0636        History Room 

Mobile Computing Wayne Kleinstiver   June 20                   539-8538  History Room 

June 
Sunday Monday Tuesday Wednesday Thursday Friday Saturday 

  
 

   1 2 

3 4 5   6 
Cameras, Scan-
ners & Printers 
6 -  7:30 p.m. 

7 
Using Personal 

Computers 
2—5  p.m. 

8 9 

10 11 12 
MS Office 

Power Point 
2 –4 p.m. 

13 
 

14 15 16 

17 18 19 20 21 22 23 

24 25 26 27 28 29 30 

Photoshop 
Elements 
1 –3 p.m. 

 

MACs 
10—  noon 

Mobile Computing 
Surfing Internet 

6:00—7:30 

Monthly 
Meeting 
7:00 PM 
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The Mac Corner by  Eleanor Ryan 
 
Techniques Mac OS X Tips Resources  Tip of the Week 

Burning Multiple Times to the Same CD 

Generally, when you burn files to a CD once, you’re done — you can’t burn to 
that CD again. Unless you use this little trick: First create a new folder and 
give it a descriptive name (something like “burn baby burn!” Kidding). Now 
put the files you want to burn into that folder, then go to the Applications 
folder and open the Utilities folder. Double-click on Disk Utility. When it 
comes up, go under the File menu, under New, and choose Disk Image from 
Folder, and then when the Open dialog appears, find that folder with the 
stuff you want to burn and click the image button. A Save dialog appears in 
which you can leave the name as is or choose a new name (leave the other 
controls alone), and then click Save. In a few moments, a disk image of your folder’s contents will appear in the list on the left 
side of the Disk Utility dialog. Click on that icon, and then click the burn button at the top left of the Disk Utility dialog. 

When you click the Burn button, a dialog will appear asking to insert a disc. Do so, and then click once the blue downward-
facing triangle on the right side of this dialog to show more options. Click on the checkbox for Leave disc appendable, then 
click the Burn button. Your data will now be written to that CD. To add more files later, just insert that same CD and then you’ll 
use this same process all over again, but when you get to that final burn dialog, the button won’t say “Burn” this time, instead 
it will say “Append” because you’re adding these files to the same disc. By the way, don’t forget to remove the files you already 
burned to this disc from your “burn baby burn!” folder (and the DMG file it creates) before you make your next disc image. 

 
One thing we all use on our computers is email. A few hints are always useful. Have you ever noticed how freaked out relatives 
get when you email the high-res photos from your six or eight-meg digital camera? For example, your grandmother in 
Minnesota may not have PhotoShop CS2, and so dealing with that 26MB, 41 inchwide photo you shot with your eight- meg 
camera might put a strain on her system. That’s why you might want to reduce the size of those photos you’re about to email. 
You don’t even have to launch PhotoShop because you can do the resizing right within mail.  
 
After you attach a photo to your email message, you can just (drag and drop the image into the New Message window), take a 
look in the bottom -right corner of your email message window and you’ll see a pop-up menu where you can choose the Image 
Size you’d like to send. As soon as you choose a size (other than the Actual Size), the image is immediately scaled down right 
within the email message window so you can see the exact size of the photo you’re sending.  
 
Did you know that .Mac scans your email for viruses?  
 
All messages went to your Mac.com email address are automatically scanned by the mail server for viruses. If the mail server 
detects a virus, the virus is deleted before it reaches your Mac.  
 
Although the Macintosh operating system is not affected by 
most viruses, the mail server detection process also targets 
Microsoft Windows-based viruses. Even if one of those 
Windows-based viruses were to reach your computer, because 
you’re using a Mac, you will not inadvertently pass it along to 
computer that may be vulnerable to it. 
 
Here is a link to using Mac Mail. 
Apple - Support - Mac OS X v10.4 Tiger - Using Mac OS X Mail 
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The SIGs 
If you are not attending a SIG, you are missing 
more than you know. Ask someone who attends 
them each month. It is well worth your time. All 
you have to do is bring your questions and a pen-
cil and paper. You can even bring a guest if you 

Tips from the Association of Personal Computer User Groups—APCUG 

 

Mouse Tip (DG) 

If you're using a wireless optical mouse then get a white or light-colored mouse pad. The mouse's infrared 
transmitter/receiver uses less power if it's reading a light-colored surface. This will make your batteries last 
longer. 

 

Inkjet Printer Care 

Kathy Frey, Computer Club of Green Valley 

  

If you are leaving for the summer months, take care of your printer before you leave.  Printers should not 
sit for months with the ink cartridges left installed in the printer.  Consult your printer manual for proper 
removal. 

  

Even if you just installed a new cartridge, you will need to remove it.  Wrap the cartridge tightly, with either 
or a combination of Saran wrap, aluminum foil, and a resealable plastic bag.  Remove as much air as possi-
ble from the packaging.  Store in the vegetable compartment of your refrigerator.  The vegetable compart-
ment has some moisture which will help keep the cartridge from drying out. 

  

There is no guarantee that the cartridges will not dry out and therefore be unusable.  However, taking pre-
cautions before you leave may save you the cost of purchasing a new cartridge. 

 

Word Tips 

 

Paste Special (DG) 

You can tell Word how to paste your text before you paste it, by using the Edit, Paste Special command. If 
you don't see this command on the Edit menu, click the down arrow at the bottom of the Edit menu. The full 
menu appears, including the Paste Special option. 

  

Choose the Paste Special command. The Paste Special dialog box appears, which lists several options for 
pasting in the text: Document Object, Formatted Text, Unformatted Text, Picture, and so on. Each of these 
items tells Word how to paste in the information. To discover what each options does, select it from the list 
and read the description in the Result area of the dialog box. 

  

For example, if you want to paste in some text from a Web page but don't want all that HTML-blah-blah for-
matting, choose the Unformatted Text option. Click OK, and the text is pasted into Word as plain text and 
not as some Web object. 
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